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Introduction

Welcome to Adobe Muse on Demand, a visual quick refer-
ence book that shows you how to work efficiently with Muse.
This book provides complete coverage of basic to advanced
Muse skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

How You’ll Learn

How This Book Works

Step-by-Step Instructions

Exercise Files

Get Updates

Adobe Software

Workshops
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
how to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, whereas a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Exercise Files
The Workshops section 
of this book uses exercise files 
that are available to you. 
You can locate these files on 
the Web by navigating to
www.queondemand.com. By 
following along with the exercise
files, you won’t waste time 
looking for or creating your own
assets. Note that not every task
requires an exercise file, and
some require the use of your own 
images.

Exercise files
enable you to
follow along
with the steps.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques,
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
instructions
focus on a single
concept.

www.queondemand.com


Get Updates
Like any software, Muse 
continues to change and get 
better with updates and patches, 
so it’s important to regularly check
the Adobe Muse site at
muse.adobe.com.

Adobe Software
Muse is part of the Adobe software
family, and can be used in conjunc-
tion with Photoshop CS6, Photoshop
CS6 Extended, and Fireworks CS6.
For more info about Photoshop,
Fireworks, and the Adobe Creative
Suite, please visit www.adobe.com/
products/creativesuite.html.

Get updates 
for Muse online.

The Adobe
Creative Suite
family includes
several other
professional
image-editing
products.

Introduction xv

www.adobe.com/products/creativesuite.html
www.adobe.com/products/creativesuite.html
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Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file and
then work through the steps. The
Workshop projects and associ-
ated files are available on the
Web at www.queondemand.com.

The Workshop
walks you
through in-depth
projects to help
you put Muse 
to work.

www.queondemand.com
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Introduction

After you’ve spent some time becoming familiar with the
Muse work environment, the next step is to create a new
website from scratch. Thankfully, by utilizing the sitemap
features available in Plan Mode, creating and planning a
new website has never been easier.

With this chapter, you’ll learn how to use the New Site
dialog box to specify the page size for your new site, as
well as the placement of margin and column guides and
the amount of padding to leave between the pages and the
edges of the browser. After you create a new site docu-
ment, you’ll learn how to add, rearrange, and delete
pages—all by working with the sitemap page thumbnails in
Plan Mode.

This chapter also shows you how to create and apply
master pages. By utilizing master pages, you can ensure
that any repeating page elements, such as nav bars and
footers, maintain their position throughout your site. This is
achieved by placing the repeating elements on a master
page, and then applying the master page to site pages. 

Additionally, you’ll learn how to fill the browser with a
background color or image and set objects to display at
100% browser width. The final sections of the chapter
explain how to save and close your website projects.

Creating and Planning 
a Website 3

3
29

What You’ll Do

Creating a New Site

Adding Top Level (Sibling) Pages to the
Sitemap

Adding Child Pages to the Sitemap

Adding Master Pages to the Sitemap

Removing Pages from the Sitemap

Rearranging Pages in the Sitemap

Resizing Sitemap Thumbnails

Filling the Browser with a 
Background Color

Filling the Browser with a 
Background Image

Applying Master Pages

Saving a Site

Closing a Site



30

When you create a new site in Muse, you must indicate what page
dimensions you’d like to use, as well as where to place the margin
and column guides. This is done by entering values in the New Site
dialog box, which appears whenever you choose New Site from the
File menu, or by clicking the New Site button in the Welcome
Screen. The entire process is similar to creating a new page in
InDesign. 

Creating a New Site

Use the Welcome Screen

Launch Muse, as described in
Chapter 1 “Getting Started with
Adobe Muse.” This process
varies depending on what
platform you are on (Mac OS X
or Windows).

By default, the Welcome Screen
automatically appears.

Click the Create New Site
button in the upper left of the
Welcome Screen.

Muse displays the New Site
dialog box. 

Enter the preferred pixel
dimensions in the Page Width
and Min Height fields.
Generally, 1280 width by 1024
height is considered a standard
size.

To center the web pages
horizontally in the browser
window, place a check in the
Center Horizontally checkbox.

4

3

2

1
1

See Also
See Chapter 1, “Getting Started with
Adobe Muse,” to learn more about
launching the application and accessing
the Welcome Screen.

2

3

4
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Enter the preferred values in the
Columns, Column Width, and
Gutter fields. These values
determine where the column
guides are positioned on the
pages.

Enter the preferred values in the
Top, Bottom, Left, and Right
Margins fields. These values
determine the amount of space
surrounding the content on each
page, as indicated by the margin
guides.

Enter values in the Top, Bottom,
and Left Padding fields to
determine the amount of space
placed between the web pages
and the edges of the web
browser.

IMPORTANT When you enable
the Center Horizontally option (see
Step 4), you cannot enter a value in
the Left Padding field. The option
appears “grayed out” in the dialog
box. This is because the padding
between your page and the left
edge of the browser will change
automatically depending on the
size of the browser window.

Click OK to apply the New Site
settings.

Muse displays the new site in Plan
Mode.

8

7

6

5

Did You Know?
You can change these site settings at
any time via the Site Properties dialog
box. To do so, choose Site Properties
from the File menu. Enter the new page
dimensions, margin and column guide
settings, and padding settings and click
OK to apply them to your site.

5

8

6
7
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Choose the New Site command

Choose New Site from the File
menu.

TIMESAVER Press Cmd+N
(Mac) or Ctrl+N (Win) to apply the
New Site command quickly.

Muse displays the New Site 
dialog box. 

Enter the preferred pixel
dimensions in the Page Width and
Min Height fields.

To center the web pages
horizontally in the browser
window, place a check in the
Center Horizontally checkbox.

Enter the preferred values in the
Columns, Column Width, and
Gutter fields. These values
determine where the column
guides are positioned on the
pages.

Enter the preferred values in the
Top, Bottom, Left, and Right
Margins fields. These values
determine the amount of space
surrounding the content on each
page, as indicated by the margin
guides.

Enter values in the Top, Bottom, and
Left Padding fields to determine the
amount of space placed between
the web pages and the edges of
the web browser.

IMPORTANT When you enable
the Center Horizontally option (see
Step 3), you cannot enter a value in
the Left Padding field. The option
appears “grayed out” in the dialog
box.

Click OK to apply the New Site
settings.

Muse displays the new site in Plan
Mode.

7

6

5

4

3

2

1

2

3
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5

4

7
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In Plan Mode, you can use the sitemap to create the page structure
and hierarchy for your website. When you add pages, you are not
only adding them to the sitemap, but also to the site itself. By 
double-clicking the page thumbnails in the sitemap, you can open
them up in Design Mode and add page contents. You can add pages
by choosing the Add New Top Level Page command from the Page
menu, or by clicking the Insert Page buttons.

Adding Top Level
(Sibling) Pages to the
Sitemap

Choose the Add New Top Level
Page command

If you’re not already in Plan
Mode, choose Plan Mode from
the View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Choose Add New Top Level Page
from the Page menu.

TIMESAVER Press
Cmd+Shift+P (Mac) or Ctrl+Shift+P
(Win) to apply the Add New Top
Level Page command quickly.

Muse adds the page to the site.
The new page thumbnail appears
to the right of the last page in the
sitemap. Muse highlights the
page name so that you can enter
a new one.

Enter a name for the new page
and press Return (Mac) or Enter
(Win) to apply it.

3

2

1

1

2

3
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Click the Insert Page buttons

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Hover the cursor over any page
in the sitemap and click the
Insert Page button (the plus icon)
that appears to the left or right of
the thumbnail.

Muse adds the page to the site.
The new page thumbnail appears
to the left or right of whichever
button you clicked. Muse
highlights the page name so that
you can enter a new one.

Enter a name for the new page
and press Return (Mac) or Enter
(Win) to apply it.

3

2

1

Did You Know?
You can also insert top level (sibling)
pages using the contextual menu. To
do so, right-click or Control-click (Mac)
on any page in the sitemap and choose
New Sibling Page from the contextual
menu. The new page thumbnail
appears to the right of the page you
clicked.

1

2

3
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End users generally visit a child page by accessing its parent page
first. Because of this, child pages do not appear in the top level navi-
gation bar, but rather in a drop-down menu via the top level parent
page. Muse even generates and updates nav bars automatically as
you add, remove, and rearrange pages in the sitemap (see Chapter 4,
“Adding Navigational Content”). You can add child pages by clicking
the Insert Child Page button.

Adding Child Pages 
to the Sitemap

Click the Insert Child 
Page button

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Hover the cursor over any page
in the sitemap and click the
Insert Child Page button (the plus
icon) that appears underneath
the thumbnail.

Muse adds the page to the site.
The new page thumbnail appears
underneath the button you
clicked. Muse highlights the page
name so that you can enter a
new one.

Enter a name for the new page
and press Return (Mac) or Enter
(Win) to apply it.

3

2

1

Did You Know?
You can also insert child pages using
the contextual menu. To do so, right-
click or Control-click (Mac) on any
page in the sitemap and choose New
Child Page from the contextual menu.
The new page thumbnail appears
underneath the button you clicked.

1

2

3
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With master pages, you can ensure that any repeating page ele-
ments, such as nav bars and footers, maintain their position through-
out your site. This is because master page contents only appear on
the pages where the master is applied—these contents can only be
edited from the master page itself. You can access master pages
from the bottom portion of the Plan Mode window. Every new site
you create contains a single, editable master page, but you can add
as many master pages as you like. 

Adding Master Pages 
to the Sitemap

Choose the Add New Master
Page command

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Choose Add New Master Page
from the Page menu.

Muse adds the page to the site.
The new page thumbnail appears
to the right of the last page in the
sitemap. Muse highlights the
page name so that you can enter
a new one.

Enter a name for the new master
page and press Return (Mac) or
Enter (Win) to apply it.

3

2

1

Did You Know?
You can also insert master pages using
the contextual menu. To do so, right-
click or Control-click (Mac) on a master
page from the Masters section of the
sitemap and choose New Master Page
from the contextual menu. 

1

2

3



Click the Insert Master 
Page buttons

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Hover the cursor over any master
page in the Masters portion of
the sitemap and click the Insert
Page button (the plus icon) that
appears to the left or right of the
thumbnail.

Muse adds the master page to
the site. The new master page
thumbnail appears to the left or
right of whichever button you
clicked. Muse highlights the
master page name so that you
can enter a new one.

Enter a name for the new master
page and press Return (Mac) or
Enter (Win) to apply it.

3

2

1
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Removing pages from a site is just as easy as adding them. All you
need to do is hover the mouse cursor over the page thumbnail in the
sitemap and click the Delete Page button that appears. Muse
instantly removes the page from the site and also removes it auto-
matically from any navigational content (see Chapter 4, “Adding
Navigational Content”).

Removing Pages from
the Sitemap

Click the Delete Page button

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Hover the cursor over any page
or master page in the sitemap. 

The Delete Page button (the x
icon) appears in the upper-right
corner, above the page
thumbnail.

Click the Delete Page button. 

If the page contains contents
(other than master page
contents), then Muse displays
the Delete Page warning dialog
box.

Click OK to delete the page. 

Muse removes the page from the
site.

4

3

2

1

4

3
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Did You Know?
You can also delete pages using the
contextual menu. To do so, right-click
or Control-click (Mac) on any page or
master page in the sitemap and choose
Delete Page from the contextual menu.

1



With Muse, changing the page order of your website has never been
easier. By clicking and dragging the page thumbnails in the Plan
Mode sitemap, you can easily rearrange the site structure and page
hierarchy for a site. If the Include Page in Navigation feature is
enabled (Muse enables this by default), then the new site structure
and hierarchy are automatically updated in the site’s nav bars (see
Chapter 4, “Adding Navigational Content”).

Rearranging Pages 
in the Sitemap

Click and drag the page
thumbnail

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Hover the cursor over any page
or master page in the sitemap.
Click and drag the thumbnail to
move the page to a new location
in the sitemap.

To place the page between two
existing pages, drag the thumbnail
between page thumbnails until the
blue rectangle appears, and then
release the mouse button. 

To place the page under an
existing page and convert it into a
child page, drag the thumbnail
over the parent thumbnail until the
blue rectangle appears underneath
it, and then release the mouse
button.

3

2

1
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As you add more and more pages to a website, the Plan Mode
sitemap can fill up quickly with thumbnails. In order to view all of the
thumbnails at once in the window, you must decrease their size.
However, with all of the thumbnails visible, it may become too diffi-
cult to see the page names. When this happens, you must increase
their size. Thankfully, you can change the size of the sitemap thumb-
nails in one of two ways: by dragging the Size slider at the top of the
interface, or by choosing the Zoom commands from the View menu.

Resizing Sitemap
Thumbnails

Drag the Size slider

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Drag the Size slider to the left to
decrease the size of all the
thumbnails in the sitemap,
including master pages.

Muse displays the thumbnails at
the new size in the Plan Mode
window.

Drag the Size slider to the right to
increase the size of all the
thumbnails in the sitemap,
including master pages.

Muse displays the thumbnails at
the new size in the Plan Mode
window.

3

2

1

2

3
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1

Did You Know?
You can hide thumbnail previews. By
default, the thumbnail preview option is
enabled. This option displays a preview
of each page inside the sitemap thumb-
nails. While this can be a useful feature
for helping to identify the pages you
want to work with, it can also slow
down your workflow, especially when
working with sites that contain a large
number of pages. To disable the pre-
view fature, uncheck the Thumbnail
option located in the upper left of the
interface.



Choose the Zoom In/Zoom Out
commands

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Choose View > Zoom In to
increase the thumbnail size;
choose View > Zoom Out to
decrease it.

TIMESAVER Press Cmd+=
(Mac) or Ctrl+= (Win) to apply the
Zoom In command quickly; press
Cmd+- (Mac) or Ctrl+- (Win) to
apply the Zoom Out command
quickly.

Muse displays the thumbnails at
the new size in the Plan Mode
window.

2

1
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One way to maintain consistent color throughout your site is to fill
the browser window with the same background color that you’re
using on your web pages. You can achieve this effect in Muse by
using the Browser Fill feature. To make it even easier, you can use
the Browser Fill feature on a master page and apply the master to all
of your web pages. You can choose colors to work with using a tra-
ditional Color Picker, very similar to what you would use in other
Adobe products, such as InDesign, Photoshop, or Illustator.

Filling the Browser
with a Background
Color

Use the Browser Fill Color
option

In Plan Mode, double-click a new
page or master page thumbnail
from the sitemap. 

Muse opens the page in Design
Mode.

Click the Browser Fill Color
swatch in the Control panel.

Muse displays a drop-down Color
Picker. 

Choose a background color with
the Color Picker via any of the
following methods:

◆ Enter values into the RGB fields.

◆ Enter a hexadecimal code in the
Hex# field.

◆ Click a swatch from the saved
color swatch list.

◆ Drag the Hue slider up or down
to select a color hue. Then click
in the color field to the right of
the Hue slider to determine the
saturation and brightness of the
selected color.

◆ Click the Sample Color tool icon.
To sample a color for the
background, proceed to click
anywhere on the
page—including in a placed
photo or graphic.

Muse fills the browser with the
chosen background color.

3

2

1

2

3

1

Muse fills the browser with the chosen background color.
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In web design it’s very common to fill the browser window with a
tiled background graphic. By doing so, the background graphics
repeat endelssly whenever you enlarge the browser window. You
can also incorporate tiled graphics into your overall site design by
placing page contents, such as nav bars, text, or photos, over them.
One of the best ways to utilize tiled graphics is to fill the browser
with them on your master pages. You can also fill a rectangle with
tiled graphics and place them as page contents or as footers (see
Chapter 5, “Working with Graphics”).

Filling the Browser
with a Background
Image

Use the Browser Fill Image
option

In Plan Mode, double-click a new
page or master page thumbnail
from the sitemap. 

Muse opens the page in Design
Mode.

Click the Browser Fill button in the
Control panel.

Muse displays a drop-down Fill
panel. 

Click the Choose Background
Image button (the folder icon).

Muse displays the Import dialog
box.

Using the Import dialog box,
navigate to the background image
on your system disk. Click the
image file to select it and then
click Select. 

IMPORTANT You can only
import images saved in the
following file formats: PNG, PSD,
JPEG, and GIF.

Muse fills the browser with the
chosen background image.

4

3

2

1

1

2

3

4
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Choose a fitting option from the
Fitting drop-down list. Options
include: Original Size, Tile, Tile
Horizontally, and Tile Vertically.

IMPORTANT The Tile options
enable you to repeat the image in
the brower background. The Tile
option repeats the image both
horizontally and vertically.

Click one of the small squares next
to the Position option in the Fill
drop-down panel. By doing so, you
can determine where the image
starts repeating from in the
browser window.

Enable the Scrolling option to
allow tiled background graphics
(that do not fill the entire browser
window) to move with the rest of
the page contents when scrolling. 

Disable the Scrolling option if
you’d like the tiled background
graphics to remain fixed in position
as you scroll the page in a
browser.

7

6

5 5

6

7



When you apply a master page, all master page contents are applied
to a site page and can only be edited from the master. By default,
whenever you create a new site, the A-master page is automatically
applied to the intial web page and any additional pages you add.
However, when you create additional master pages in Plan Mode,
you can apply them to your site pages by dragging-and-dropping the
master page thumbnail over the page thumbnail in the sitemap. You
can also change the master page that is currently applied to a site
page by choosing a diferent master from the contextual menu. 
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Applying Master
Pages

Drag-and-drop the master page
thumbnail

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Click and drag the master page
thumbnail over the site page
thumbnail in the sitemap.

Muse displays a blue rectangle
around the site page thumbnail. 

Release the mouse button to apply
the master page to the site page.

Muse adds the master page
contents to the site page.

3

2

1

Did You Know?
You can hide master badges. By
default, the name of the applied master
page appears underneath the thumb-
nail for each page in the sitemap. To
hide the master badge, uncheck the
Master Badge option located in the
upper-left corner of the interface.

1

2

3
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Choose a master page from 
the contextual menu

Choose Plan Mode from the
View menu.

TIMESAVER Press Cmd+M
(Mac) or Ctrl+M (Win) to apply the
Plan Mode command quickly.

Right-click or Control-click (Mac)
on any page in the sitemap to
access the contextual menu.
Choose the master page from the
Masters submenu.

Muse adds the master page
contents to the site page.

2

1

Did You Know?
You can also apply no master page at
all. To do so, right-click or Control-click
(Mac) on any page in the sitemap to
access the contextual menu. Choose
No Master from the Masters submenu.
Muse removes all master page con-
tents from the page.

1

2

Muse adds the master page contents to the chosen site page.



Creating and Planning a Website 47

As it is when working with any design software, it’s always a good
idea to save often. With Muse, you can save your website projects
at any time, no matter whether you are working in Plan Mode,
Design Mode, or Preview Mode. To do so, choose Save Site from the
File menu. When you do, Muse saves all of the data for the entire
site, including all pages, master pages, and their respective con-
tents. To create a copy of a site, or create a different version of it,
choose Save Site As. 

Saving a Site

Choose Save Site

Choose Save Site from the File
menu.

TIMESAVER Press Cmd+S
(Mac) or Ctrl+S (Win) to apply the
Save Site command quickly.

IMPORTANT You can choose
the Save Site command from the
File menu at any time, while
working in any of the three modes
(Plan, Design, or Preview).

IMPORTANT When saving a
site for the first time, Muse
displays the Save Muse File As
dialog box. You can use this dialog
box to name the file and choose a
save location for it on your system.

Choose Save Site As

Choose Save Site As from the File
menu.

TIMESAVER Press
Shift+Cmd+S (Mac) or Shift+Ctrl+S
(Win) to apply the Save Site As
command quickly.

IMPORTANT You can choose
the Save Site As command from
the File menu at any time, while
working in any of the three modes
(Plan, Design, or Preview).

Muse displays the Save Muse
File As dialog box. 

Using the Save Muse As dialog
box, navigate to a save location on
your system disk and then click
Save. 

2

1

1

1

1

2



Just as it is with saving sites in Muse, you can also close your 
website projects at any time, no matter whether you are working in
Plan Mode, Design Mode, or Preview Mode. To do so, choose Close
Site from the File menu. When you do, Muse closes all of the pages
for the entire site, including the sitemap.

Closing a Site

Choose the Close Site command

Choose Close Site from the File
menu.

TIMESAVER Press
Shift+Cmd+W (Mac) or
Shift+Ctrl+W (Win) to apply the
Close Site command quickly.

IMPORTANT You can choose
the Close Site command from the
File menu at any time, while
working in any of the three modes
(Plan, Design, or Preview).

If the site contains any unsaved
changes, Muse displays the
Unsaved Changes warning dialog
box. To save changes before
closing the site, click Save. To
close the site without saving any
changes, click Don’t Save.

2

1
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Symbols
+ (plus symbol)

in graphic styles, 99
style overrides, 126, 128

100% browser width, displaying 
graphics at, 86

A
accounts, Creative Cloud, creating, 5-8
Active rollover state images, inserting,

62-63
Actual Size command, 23
Add Images button, 152-153
Add New Master Page command, 36
Add New Top Level Page command, 33
Adobe Application Manager, 5-8
Adobe Muse

downloading installer, 5-8
installing, 5-8
launching, 9-10
subscriptions, purchasing, 2-4

alignment (text), 111
anchor links

applying, 145-146
creating, 144

applying
anchor links, 145-146
bold text, 110

character styles, 124-125
font styles, 110
graphic styles, 100-101
italic text, 110
link styles, 142-143
master pages, 45-46
paragraph styles, 126-127
span tags, 133-134
underlined text, 110

arbitrary HTML
editing, 176
Google Maps, inserting, 168-170
Twitter Search Widgets, inserting,

173-175
YouTube/Flickr/Hulu videos, 

inserting, 171-172
Auto Play options in slideshows/

compositions, 162

B
background color, filling browser 

with, 42
background image, filling browser 

with, 43-44
Bar Menu widget, 53
bevel effects, 93-94
bold text, applying, 110
browser location, pinning graphics 

to, 85
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browser window
filling

with background color, 42
with background image, 43-44

resizing graphics with, 86
browsers

default browser
previewing web pages, 180
previewing websites, 181

non-default browsers, previewing 
websites, 182-183

Business Catalyst, publishing websites to,
186-187

updating changes, 188-189
buying Muse subscriptions, 2-4

C
changing

leading (text), 115
letter spacing, 114
margins, 117
opacity, 97
paragraph spacing, 118
text color, 112-113
view percentage, 19-21

character styles
applying, 124-125
clearing overrides, 130
deleting, 132
overriding, 128
redefining, 129
saving, 120-121
span tags, 133-134
unlinking, 131

child pages
adding to sitemap, 35
in drop-down menus, 55

choosing
link colors, 141
text, 106
tools, 16

Clear Overrides command, 130
clearing

graphic style overrides, 100
style overrides, 130

Close Site command, 48
closing sites, 48
collapsing panels, 18
colors

background color, filling browser with, 42
for drop shadows, 92
fill colors in menus, editing, 56-57
for glow effects, 96
for links, selecting, 141
of text, changing, 112-113

column guides, setting, 30
compositions

adding, 148-149
elements

enabling/disabling, 165
moving, 156

images
Auto Play options, 162
deleting, 154
editing rollover functionality, 158-160
enabling Lightbox feature, 163-164
object formatting for, 154
placing, 150-153
resizing, 155
transition options, 161

text, editing, 157
Content Grabber, 71
Control panel

Rotation Angle field, 78
Width and Height fields, 70
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Copy command, 104
copying text, 104
corner effects (graphics), 90
Creative Cloud accounts, creating, 5-8
Crop tool, 69
cropping graphics, 69-70

D
default browser

previewing web pages, 180
previewing websites, 181

Delete Page button, 38
Delete Style command, 132
deleting

graphic styles, 102
graphics, 76
images from slideshows/

compositions, 154
pages from sitemap, 38
styles, 132

Design Mode, 11
actual size view percentage, 23
changing view percentage, 19-21
collapsing/expanding panels, 18
fitting page in window, 22
hiding

grid overlay, 28
Header/Footer guides, 26
page guides, 25
panels, 17
rulers, 24
smart guides, 27

returning to, 14
selecting tools, 16
viewing

grid overlay, 28
Header/Footer guides, 26
page guides, 25
panels, 17

rulers, 24
sites, 14-15
smart guides, 27

disabling
slideshow/composition elements, 165
thumbnail previews, 40
Welcome Screen, 12

Dock, launching Muse, 9
docking panel column, 18
downloading Muse installer, 5-8
drag-and-drop

duplicating graphics, 80
importing graphics, 67

drop-down menus, adding, 55
drop shadows, 91-92
Duplicate command, 79
duplicating graphics, 79-80

E
Edit Original command, 83-84
editing

arbitrary HTML, 176
graphic styles, 100
graphics, round-trip editing, 83-84
menus

fill colors, 56-57
rollover states, 61
size and spacing, 60
text attributes, 58-59

rollover functionality in slideshows/
compositions, 158-160

text in slideshows/compositions, 157
websites, updating changes to trial site,

188-189
Effects panel

bevel effects, 93-94
drop shadows, 91-92
glow effects, 95-96

email links, creating, 138
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embedding
Google Maps, 168-170
Twitter Search Widgets, 173-175
YouTube/Flickr/Hulu videos, 171-172

enabling
Lightbox feature, 163-164
slideshow/composition elements, 165

expanding panels, 18
Export as HTML command, 182-183, 190-191
exporting HTML, 190-191
external page links, creating, 137

F
file formats for graphics, 66
FileZilla, 191
fill colors

for browser background, 42
in menus, editing, 56-57

Fill panel
deleting graphics, 76
filling frames with graphics, 72-73
replacing graphics, 74-75

filling
frames with graphics, 72-73
browser

with background color, 42
with background image, 43-44

Fit Page in Window command, 22
Flickr videos, inserting, 171-172
fonts. See also text

in menus, editing, 58-59
styles, applying, 110
system fonts, 108
web safe fonts, 107

footer, creating, 51
Footer guides, viewing/hiding, 26
formatting slideshow/composition 

images, 154

frames
filling with graphics, 72-73
repositioning graphics inside, 71

FTP clients, 191

G
GIF file format, 66
glow effects, 95-96
Google Maps, inserting, 168-170
graphic styles

applying, 100-101
deleting, 102
saving, 98-99
unlinking from, 98

graphics
adding links to, 136-137
Active rollover state images, inserting,

62-63
applying anchor links to, 146
background image, filling browser with,

43-44
bevel effects, 93-94
corner effects, 90
cropping, 69-70
deleting, 76
drop shadows, 91-92
duplicating, 79-80
file formats, 66
filling frame with, 72-73
glow effects, 95-96
graphic styles

applying, 100-101
deleting, 102
saving, 98-99
unlinking from, 98

importing via drag-and-drop, 67
linking, 190

before exporting as HTML, 182



images 197

opacity, changing, 97
Photoshop buttons, placing, 81-82
pinning to browser location, 85
placing, 66
replacing, 74-75
repositioning inside frames, 71
resizing, 68

with browser window, 86
rotating, 77-78
round-trip editing, 83-84
in slideshows/compositions

Auto Play options, 162
deleting, 154
editing rollover functionality, 158-160
enabling Lightbox feature, 163-164
object formatting for, 154
placing, 150-153
resizing, 155
transition options, 161

text wraps, creating, 88-89
tiling, 79
updating, 186, 188

grid overlay, viewing/hiding, 28
guides, viewing/hiding, 25

H
header, creating, 50
Header guides, viewing/hiding, 26
Height field (Control panel), 70
hero images, fitting, 150
hiding

anchor links, 146
grid overlay, 28
Header/Footer guides, 26
master badges, 45
page guides, 25
panels, 17

rulers, 24
smart guides, 27
thumbnail previews, 40
Welcome Screen, 12

highlighting. See selecting
Horizontal Menu widget, 52
hosting services, uploading to, 191
HTML

arbitrary HTML
editing, 176
Google Maps, inserting, 168-170
Twitter Search Widgets, inserting, 

173-175
YouTube/Flickr/Hulu videos, inserting,

171-172
exporting, 190-191

HTML command, 176
Hulu videos, inserting, 171-172
hyperlinks

anchor links
applying, 145-146
creating, 144

email links, creating, 138
external links, creating, 137
opening in separate window/tab, 139
previewing, 139
within the site, creating, 136

I
images

adding links to, 136-137
Active rollover state images, inserting,

62-63
applying anchor links to, 146
background image, filling browser with,

43-44
bevel effects, 93-94
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corner effects, 90
cropping, 69-70
deleting, 76
drop shadows, 91-92
duplicating, 79-80
file formats, 66
filling frame with, 72-73
glow effects, 95-96
graphic styles

applying, 100-101
deleting, 102
saving, 98-99
unlinking from, 98

importing via drag-and-drop, 67
linking, 190

before exporting as HTML, 182
opacity, changing, 97
Photoshop buttons, placing, 81-82
pinning to browser location, 85
placing, 66
replacing, 74-75
repositioning inside frames, 71
resizing, 68

with browser window, 86
rotating, 77-78
round-trip editing, 83-84
in slideshows/compositions

Auto Play options, 162
deleting, 154
editing rollover functionality, 158-160
enabling Lightbox feature, 163-164
object formatting for, 154
placing, 150-153
resizing, 155
transition options, 161

text wraps, creating, 88-89
tiling, 79
updating, 186, 188

importing. See also placing
graphics

via drag-and-drop, 67
filling frame with, 72-73
with Place command, 66
into slideshows/compositions, 150-153

text
by copying/pasting, 104
with Place command, 105

indenting text, 116
inline graphics, placing, 88-89
Insert Child Page button, 35
Insert Page button, 34, 37
inserting

Active rollover state images, 62-63
Google Maps, 168-170
Twitter Search Widgets, 173-175
YouTube/Flickr/Hulu videos, 171-172

installing Muse, 5-8
internal page links, creating, 136
italic text, applying, 110

J–K
JPEG file format, 66

kerning text, 114
keyboard shortcuts

leading (text), 115
letter spacing, 114
selecting tools, 16
sizing text, 109
text alignment, 111

L
launching Muse, 9-10
leading (text), changing, 115
letter spacing, changing, 114
Lightbox feature in slideshows/

compositions, enabling, 163-164
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link styles
applying, 142-143
creating, 140-141

linking images, 190
before exporting as HTML, 182

links
anchor links

applying, 145-146
creating, 144

email links, creating, 138
external links, creating, 137
opening in separate window/tab, 139
previewing, 139
within the site, creating, 136

M
Mac OS X, launching Muse, 9
margins

changing, 117
setting, 30

master badges, hiding, 45
master pages

adding to sitemap, 36-37
applying, 45-46
footer, creating, 51
header, creating, 50

menu widgets, 49
Bar Menu, 53
drop-down menus, adding, 55
Horizontal Menu, 52
Vertical Menu, 54

menus
Active rollover state images, inserting,

62-63
fill colors, editing, 56-57
resizing, 60
rollover states, editing, 61

size and spacing, editing, 60
text attributes, editing, 58-59

moving
graphics inside frames, 71
pages in sitemap, 39
slideshow/composition elements, 156

Muse
downloading installer, 5-8
installing, 5-8
launching, 9-10
subscriptions, purchasing, 2-4

N
navigational elements. See also menus

Bar Menu widget, 53
drop-down menus, adding, 55
Horizontal Menu widget, 52
Vertical Menu widget, 54

New Site command, 32
New Site dialog box, 30-32
non-default browsers, previewing websites,

182-183

O
opacity, changing, 97
opening

links in separate window/tab, 139
sites, 13

outdenting text, 116
overriding

graphic styles, 99-100
styles, 128

clearing overrides, 130

P
page dimensions, setting, 30
page guides, viewing/hiding, 25
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pages. See also sites
child pages

adding to sitemap, 35
in drop-down menus, 55

fitting in window, 22
links to, creating, 136
master pages

adding to sitemap, 36-37
applying, 45-46
footer, creating, 51
header, creating, 50

previewing
in default browser, 180
in Muse, 178

rearranging in sitemap, 39
removing from sitemap, 38
top level pages, adding to sitemap, 33-34

panel column, docking, 18
panels

collapsing/expanding, 18
viewing/hiding, 17

paragragh indents, 116
paragraph spacing, changing, 118
paragraph styles

applying, 126-127
clearing overrides, 130
deleting, 132
link styles in, 143
overriding, 128
redefining, 129
saving, 122-123
span tags, 133-134
unlinking, 131

Paste command, 104
pasting text, 104
photos. See images
Photoshop buttons, placing, 81-82
pinning graphics to browser location, 85
Place command, 66, 105, 150-151
Place Photoshop Button command, 81-82

placing. See also importing
anchor links, 144
graphics, 66

inline, 88-89
in slideshows/compositions, 150-153

Photoshop buttons, 81-82
text

by copying/pasting, 104
with Place command, 105

Plan Mode, 11
returning to, 15
sitemap. See sitemap
viewing sites, 13

plus symbol (+)
in graphic styles, 99
style overrides, 126, 128

PNG file format, 66
Preview command, 139
Preview Mode, 178-179
Preview Page in Browser command, 180
Preview Site in Browser command, 181
previewing

links, 139
web pages

in default browser, 180
in Muse, 178

websites
in default browser, 181
in Muse, 179
in non-default browsers, 182-183

PSD file format, 66
placing Photoshop buttons, 81-82

Publish command
publishing to trial site, 186-187
updating changes to trial site, 188-189

publishing websites
exporting HTML, 190-191
to trial site, 186-187
updating changes to trial site, 188-189

purchasing Muse subscriptions, 2-4
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Q–R
rearranging pages in sitemap, 39
Rectangle tool, 72
Redefine Style command, 129
redefining styles, 129
removing

graphic styles, 102
graphics, 76
images from slideshows/

compositions, 154
pages from sitemap, 38
styles, 132

renaming
character styles, 121
graphic styles, 99
paragraph styles, 123

replacing
deleted styles, 132
graphic styles, 102
graphics, 74-75

repositioning
graphics inside frames, 71
pages in sitemap, 39
slideshow/composition elements, 156

resizing
graphics, 68

with browser window, 86
in slideshows/compositions, 155

menus, 60
sitemap thumbnails, 40-41

rollover functionality of thumbnail images,
editing, 158-160

rollover states
Active rollover state images, inserting,

62-63
in menus, editing, 61

rotating graphics, 77-78
Rotation Angle field (Control panel), 78
round-trip editing of graphics, 83-84
rulers, viewing/hiding, 24

S
Save Site As command, 47
Save Site command, 47
saving

character styles, 120-121
graphic styles, 98-99
paragraph styles, 122-123
sites, 47

selecting
link colors, 141
text, 106
tools, 16

Selection tool
repositioning graphics inside frames, 71
resizing

graphics, 68
slideshow/composition images, 155

rotating objects, 77
shadows, 91-92
showing

anchor links, 146
grid overlay, 28
Header/Footer guides, 26
page guides, 25
panels, 17
rulers, 24
sites

in Design Mode, 14-15
in Plan Mode, 13

smart guides, 27
Welcome Screen, 12

Site Properties dialog box, 31
accessing, 140

sitemap
child pages, adding, 35
master pages

adding, 36-37
applying, 45-46

rearranging pages in, 39
removing pages from, 38
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resizing thumbnails, 40-41
returning to, 15
top level pages, adding, 33-34

sites. See also pages
closing, 48
creating, 30-32
external links, creating, 137
internal links, creating, 136
opening, 13
previewing

in default browser, 181
in Muse, 179
in non-default browsers, 182-183

publishing
exporting HTML, 190-191
to trial site, 186-187
updating changes to trial site, 188-189

saving, 47
viewing

in Design Mode, 14-15
in Plan Mode, 13

size of menus, editing, 60
Size slider, 40
sizing text, 109
slideshows

adding, 148-149
elements

enabling/disabling, 165
moving, 156

images
Auto Play options, 162
deleting, 154
editing rollover functionality, 158-160
enabling Lightbox feature, 163-164
object formatting for, 154
placing, 150-153
resizing, 155
transition options, 161

text, editing, 157
smart guides, viewing/hiding, 27

spacing
between paragraphs, changing, 118
in menus, editing, 60

span tags, applying to styles, 133-134
States panel, 61-63
styles

character styles
applying, 124-125
saving, 120-121

clearing overrides, 130
deleting, 132
graphic styles

applying, 100-101
deleting, 102
saving, 98-99
unlinking from, 98

link styles
applying, 142-143
creating, 140-141

overriding, 128
paragraph styles

applying, 126-127
link styles in, 143
saving, 122-123

redefining, 129
span tags, 133-134
unlinking, 131

subscriptions to Muse, purchasing, 2-4
system fonts, 108

T
tabs, opening links in, 139
text

adding links to, 136-137
alignment, 111
applying bold/italic/underline, 110
character styles

applying, 124-125
saving, 120-121

color, changing, 112-113
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importing
by copying/pasting, 104
with Place command, 105

leading, changing, 115
letter spacing, changing, 114
margins, changing, 117
paragraph indents, 116
paragraph spacing, changing, 118
paragraph styles

applying, 126-127
link styles in, 143
saving, 122-123

selecting, 106
sizing, 109
in slideshows/compositions, editing, 157
styles

clearing overrides, 130
deleting, 132
overriding, 128
redefining, 129
span tags, 133-134
unlinking, 131

system fonts, 108
web safe fonts, 107

text attributes in menus, editing, 58-59
Text tool, selecting text, 106
text wraps, creating, 88-89
thumbnail images

disabling previews, 40
editing rollover functionality, 158-160
fitting, 150
in sitemap, resizing, 40-41

tiling graphics, 79
filling browser with, 43-44

tools, selecting, 16
top level pages, adding to sitemap, 33-34
Transform panel

Rotation Angle field, 78
Width and Height fields, 70

transition options in slideshows/
compositions, 161

trial site, publishing websites to, 186-187
updating changes, 188-189

troubleshooting
linked images, 182, 190
updated images, 186, 188

Twitter Search Widgets, inserting, 173-175

U
underlined text, applying, 110
Unlink Style command, 131
unlinking

from graphic styles, 98
styles, 131

updating
changes to trial site, 188-189
images, 186, 188

uploading to hosting services, 191
URLs, creating external links, 137

V
Vertical Menu widget, 54
videos, inserting, 171-172
view percentage

actual size, 23
changing, 19-21
fitting page in window, 22

viewing
anchor links, 146
grid overlay, 28
Header/Footer guides, 26
page guides, 25
panels, 17
rulers, 24
sites

in Design Mode, 14-15
in Plan Mode, 13

smart guides, 27
Welcome Screen, 12
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W
web pages. See also websites

child pages
adding to sitemap, 35
in drop-down menus, 55

fitting in window, 22
links to, creating, 136
master pages

adding to sitemap, 36-37
applying, 45-46
footer, creating, 51
header, creating, 50

previewing
in default browser, 180
in Muse, 178

rearranging in sitemap, 39
removing from sitemap, 38
top level pages, adding to sitemap, 33-34

web safe fonts, 107
WebKit, 178
websites. See also web pages

closing, 48
creating, 30-32
external links, creating, 137
internal links, creating, 136
opening, 13
previewing

in default browser, 181
in Muse, 179
in non-default browsers, 182-183

publishing
exporting HTML, 190-191
to trial site, 186-187
updating changes to trial site, 188-189

saving, 47
viewing

in Design Mode, 14-15
in Plan Mode, 13

Welcome Screen
creating sites, 30-31
disabling, 12
viewing/hiding, 12

Widgets Library, adding slideshows/
compositions, 148-149

Width field (Control panel), 70
windows, opening links in, 139
Windows XP/Vista/7, launching Muse, 10
wrapping text, 88-89

X–Y–Z
YouTube videos, inserting, 171-172

Zoom In/Zoom Out commands, 19, 41
Zoom percentage field, 20
Zoom tool, 21


	Contents
	Introduction
	3 Creating and Planning a Website
	Introduction
	Creating a New Site
	Adding Top Level (Sibling) Pages to the Sitemap
	Adding Child Pages to the Sitemap
	Adding Master Pages to the Sitemap
	Removing Pages from the Sitemap
	Rearranging Pages in the Sitemap
	Resizing Sitemap Thumbnails
	Filling the Browser with a Background Color
	Filling the Browser with a Background Image
	Applying Master Pages
	Saving a Site
	Closing a Site

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J–K
	L
	M
	N
	O
	P
	Q–R
	S
	T
	U
	V
	W
	X–Y–Z




